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Acknowledgement 
 
Thank you for purchasing this Quirks Medisafe Refrigerator. This refrigerator is purpose-built, for the 
storage of medical vaccines. We recommend that you read this manual before operating the Medisafe 
refrigerator and retain it for future reference.   
 
 
 
Contact Information 
 
Should you require assistance, guidance or technical support, please contact: 
 
Quirks Australia Pty Ltd.  (Head Office) 
198 Power Street 
Glendenning NSW 2761 
 
Phone: 1800 686 672  (24 Hour National Service Support) 
Fax: (02) 8805 2544 
Email:  service@quirksaustralia.com.au 
 
 
 
Medisafe Warranty 
 
Your new Medisafe vaccine refrigerator is covered by a 12 month warranty on parts and labour.  Quirks 
Australia will repair or replace, at our discretion, any component found to be faulty in workmanship or 
operation for a period of 12 months from the time of installation.   
 
Quirks Australia would like to stress the importance of reading all provided documentation and 
instructions PRIOR to the storage of any vaccine or product stock.   
 
Full instructions on the safe and appropriate operation of your unit, along with telephone support, are 
available in order to ensure that your new Medisafe refrigerator operates efficiently and to its capacity. 
 
Failure to follow instructions, especially involving setting of cabinets and start up, may result in the loss 
of or damage to valuable stock through incorrect operation of the unit. 
 
Quirks Australia cannot be held responsible for the loss of or damage to stock. 
 
Please refer to the National Vaccine Storage Guidelines: Strive for 5 (available from the Department of 
Health at http://www.immunise.health.gov.au/internet/immunise/publishing.nsf/Content/provider-store) 
for further information about vaccine storage management, or contact your local State/Territory health 
authority (contacts provided on Page 17). 
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      Quick Start Checklist 
 
 
1. Place the Medisafe refrigerator in a location with a flat, level surface, with reasonable 

clearance from walls, and not in direct sunlight. 
 
 
2.  Before plugging the refrigerator in, please allow it to sit for 12 hours after shipping, so the 

oil in the compressor will have time to settle. 
 
 
3.  Ensure that a 220-240V, 50Hz power source is available.  Connect the Medisafe refrigerator 

to the power point, and mark the power point with appropriate signs to ensure the refrigerator 
will not be accidentally unplugged or switched off. 

 
 
4.  Install the HOBOware Lite software on your computer, following instructions on Pages 3-5 

to launch the logger for the first time. 
 
 
5.  Connect the data logger to the Medisafe refrigerator by plugging the grey cable, located at 

the rear of the data control box, into the outlet marked channel 1 on the logger. 
 
 
6.  It is recommended to run the Medisafe refrigerator for at least 6 hours, prior to stocking with 

vaccines.  The refrigerator may take time to reach the desired temperature range, resulting in 
an alarm condition.  To silence the alarm, press the prg/mute button on the electronic 
controller. 

 
 
7.  Before stocking the refrigerator, perform one (1) readout of the data logger, following the 

procedure on Page 6.  Please check that the data logger is recording temperature correctly. 
 
 
8.  Relaunch the data logger, and immediately connect it to the Medisafe refrigerator. 
 
 
9.  Press the RESET button on the High/Low temperature display. 
 
 
10.  Ensure the temperature inside the refrigerator is stable, within the safe range of +2°C to 

+8°C.  You may now stock the refrigerator with vaccines.  Take care to allow for sufficient 
air flow throughout the refrigerator. Minimise door openings to maintain a stable temperature 
while the refrigerator is being stocked. 

 
 
11.  If your Medisafe refrigerator is fitted with an Auto Dialer, you may now connect it to the 

wall socket, using the standard telephone cable provided.  Move the switch at the back of the 
header control panel to the ON position.
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Getting Started 
 

 If the vaccine cabinet was shipped to you, please wait twelve hours prior to turning it on. This 
will allow the oil in the compressor time to settle after shipping. 
 

 Quirks Medisafe refrigerators are powered by electric current, which can cause serious injury. 
Any installation, cleaning, or troubleshooting must be conducted with the electrical power source 
disconnected from the unit.  
 

The following precautions should be taken while the unit is in operation: 

• Ensure the appropriate power is supplied to the unit. Note: Quirks Medisafe units are designed to 
operate at 220-240V, 50Hz. 

• Do not plug several appliances into the same multiple receptacle 
• Electrical components should not come into contact with water 
• Ensure the power cord is not damaged.  If the cord becomes damaged, it must be replaced by the 

manufacturer, a certified service agent or qualified service professional. 
 

 It is strongly recommended that any servicing of the unit be performed by Quirks Australia. 
 
 
Installation 

• Place the Medisafe refrigerator in a location with a flat surface that is approximately level, with 
reasonable clearance from any walls, and without exposure to direct sunlight. 

• Allow clearance to the right, left, back and top. This will reduce power consumption and allow 
the internal cooling system to function correctly. The unit is not to be placed in confined areas 
where air flow and heat dissipation are restricted. 

• Ensure that the appropriate power is supplied to the unit. Note: Quirks Medisafe refrigerators are 
designed to operate at 220-240V, 50Hz. National and local codes provide specific electrical and 
mechanical installation requirements and recommendations covering equipment and equipment 
wiring. 

• Plug in and turn on the power to the Medisafe refrigerator. Ensure the power point is secure, that 
the refrigerator cannot be accidentally unplugged or switched off. 

 
 
Basic Operation 
 

• The Medisafe refrigerator is pre-set for operation. 
• No buttons are to be touched except the prg/mute button, used to silence the audible alarm. 
 

 It is recommended to run the Medisafe refrigerator for 6 hours prior to loading with vaccines. 
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Stocking the Medisafe Refrigerator 
 
The Medisafe vaccine refrigerator is designed to maintain a uniform temperature inside the cabinet. To do 
so, sufficient air flow is required to prevent “cold spots” from forming. Thus, it is important that an 
appropriate level of care be taken in stocking the refrigerator. 
 

• Cool the vaccine refrigerator before stocking with vaccine. Quirks Australia recommends 
allowing the refrigerator to run for at least 6 hours prior to loading with vaccines. 

 
• Distribute stock evenly throughout the refrigerator. 

 
• Ensure vaccines with the shortest expiry are stored at the front of the refrigerator.  

 
• DO NOT place stock directly against the evaporator plate, at the rear of the refrigerator. This 

could cause the stock to freeze. 
 
• DO NOT place large cartons inside the refrigerator (i.e. at the bottom of the cabinet). Remove 

smaller boxes from the carton, and place them evenly spaced on the shelves. 
 

• Some vaccines are sensitive to ultraviolet (UV) light. Please check the specific vaccine storage 
guidelines before removing vaccines from their boxes. 

 
• If trays are used, ensure they are made of plastic, with holes to allow for sufficient air flow, and 

spaced evenly on the shelves. 
 

• DO NOT overstock the refrigerator. 
 

• If very few vaccines are stocked, thermal mass (such as cooled water bottles) should be added to 
the refrigerator in areas of open space. 

 
 
Silencing the alarm 
 
The cooling system of  the Medisafe refrigerator is controlled by an electronic controller, incorporating an 
audible and visual alarm, should the cabinet temperature fall or rise outside the specified range(+2 to 
+8°C). This is likely to occur during the first cooling cycle, and may occur if the door is left open for an 
extended period of time. 
 
To silence the alarm: press the prg/mute button on the electronic controller. 
 

 When you first turn the cabinet on, if it does not reach a temperature below 8 degrees within 
10 minutes, it will alarm. This is a normal function. All you are required to do is press the prg/mute 
button to silence the alarm and restart the cooling process. 
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Setting up the Data Logger 
 
The HOBOware Lite software (v.2.7.1 and above) is designed for use with Windows 2000/XP, Windows 
Vista, and Mac OS X.  Previous versions of the software are not compatible with Windows Vista.  Please 
contact Quirks Australia if your operating system is not supported. 
 
 
Step 1 – Installation of HOBOware Lite software 
 
It is strongly recommended that you close down all other applications prior to the installation of your new 
HOBOware Lite software.  Note: You must be logged in as an administrator on your computer to install 
the HOBOware Lite software. 
 

• Insert the CD in your computer’s CD-ROM drive. The installation program should start 
automatically. If it does not, navigate to the CD drive in My Computer and double-click on 
HOBOwareLite_Setup.exe (Mac OS X users: double-click on the HOBOwareLite.pkg icon in 
Finder) to launch the HOBOware Lite Installer. 

 
Tip: HOBOware Lite requires the Java 2 Runtime Environment. If the correct Java 2  
Runtime Environment version is not already installed on your computer, the HOBOware  
Lite Setup program will ask if you want to install it now. (You must be logged in as an  
administrator on your computer to install the Java 2 Runtime Environment.) Click Yes  
and follow the prompts. After Java 2 Runtime Environment is installed, the HOBOware  
Lite installation will continue. 

 
• Follow the prompts to install HOBOware Lite. Please agree to the terms and conditions to 

complete the installation. 
 

• HOBOware Lite should open automatically when the installation is complete (unless you uncheck 
the Launch HOBOware Lite box on the final dialog before clicking Finish). If it does not open by 
itself, double-click the HOBOware Lite icon on your desktop or, from the Start menu, select 
Programs, Onset Applications, HOBOware Lite. 

 
Mac OS X users: You will need to restart your computer to complete the installation.  
After restarting, open HOBOware Lite by double-clicking the HOBOware Lite icon in your  
computer’s Applications folder. 

 
 
Step 2 – Change Display Preferences 
 
Before using the data logger for the  
first time, it is a good idea to change the  
Default Unit System to SI.  
 

• After opening the HOBOware  
Lite software on your computer,  
click on File in the menu bar  
and move the cursor down to  
Preferences. This will display  
the HOBOware Preferences  
window. 
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In the HOBOware Preferences window, click on Display in the left menu to open the Display 
Preferences. Click on Default Unit System and change the Unit System to SI. This will ensure that 
readout temperatures are displayed in degrees Celsius. 
 

 
 
 
Step 3 – Connecting your data logger 
 

• Ensure the HOBOware Lite software is open on your system. 
 

Connect the data logger to an available USB port on your computer, using 
the USB data cable supplied.   

 
 

The opposite end of the USB cable connects to the mini-USB port on the 
data logger.  

 
• When the logger is recognized by HOBOware Lite, the right side of the status bar at the 

bottom of the HOBOware Lite window will update to reflect the number of loggers 
connected. At this point, you can begin using the logger. 

 
 
Step 4 – Launching your data logger for the first time 
 
Launching the data logger will allow the device to start recording data.  Please check the settings before 
launching the data logger for the first time. 
 

Click on the Launch icon  in the toolbar, or click on the Device 
menu in the menu bar and move the cursor down to Launch… 
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The Launch Logger screen will appear. Please review the following settings before continuing with the 
logger launch: 
 

• In the Description panel, please record your business name. It is also recommended that the 
location of the Medisafe unit be added to the description, as this will appear on all reports, etc. 

 
• In the Channels to Log panel, check (tick) channel 1. 

 Ensure that TMCx-HD (Water/Soil Temperature) is selected from the drop-down menu. 
 Channel 1 is the only box that should be checked, all others are to be unchecked. 

 
• In the Logging Interval option, set the interval to 3 minutes 

 The interval may be adjusted to suit regulatory/insurance requirements. Please note that the 
seconds (Sec) field must be changed before changing the minutes (Min).  

 
• Select Launch Options as Now. 

 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once you have reviewed the settings, click Launch to begin logging. HOBOware Lite will display the 
progress of the launch and warn you not to unplug the logger while it is being configured. 
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Step 5 – Installing data logger on Medisafe unit 
 

 Once the data logger has been launched, it should be disconnected and transferred to  
the fridge within the logging interval (default 3 min) to avoid logging incorrect readings. 
 
Once the logger is finished launching: 
 

Unplug the logger from the USB data cable and place  
on Medisafe Unit, ensuring that the temperature probe  
(grey cable, located at the rear of the data control box  
on top of your Medisafe unit) is plugged into the outlet  
marked number 1.  

 
After the logger is installed correctly, it will collect temperature  
data from the simulated vaccine core inside the refrigerator.  
Temperatures will be recorded every logging interval, as specified above, until the data logger is  
transferred to the PC to download the collected data. 
 
Note: Always use Channel 1 to keep consistent temperature data during the operation of the Medisafe. 
 
 
Step 6 – Retrieving data from the logger 
 

• Disconnect the temperature probe (grey cable) and remove logger from Medisafe unit. 
 
• Connect the data logger to your computer, following the instructions in Step 3. 

 

• Click on the Readout icon  in the toolbar, or click on the Device menu in the menu bar and 
move the cursor down to Readout…  

 
 
 
 
 
 

  
 
 
 
 
 
• Stop logger? prompt will be displayed – click Stop 
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After reading out the logger, HOBOware Lite will prompt you to Save the datafile to your chosen 
folder/location on your computer (Quirks Australia recommends using the date and location of your data 
logger as the file name). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once the datafile is saved, the Plot Setup dialog is displayed. Review the settings, ensuring that Channel 
1 is selected and the desired units are correct, then click Plot to display the temperature graph and data 
log. 
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The temperature graph and data log display the results of your deployment. Your screen will not match 
this example exactly, depending on the data recorded and the Plot Properties (see Step 8). 
 

 
 
 

At this point, your datafile has been saved to your computer, and can be accessed at a later date. You may 
choose to Print (Step 8) the temperature data, or Relaunch your logger to continue recording Medisafe 
temperature data (Step 7). 
 

 Remember to RELAUNCH your data logger before connecting it to the Medisafe refrigerator! 
 
 
Step 7 – Relaunching your data logger 
 
As in Step 4, launching the data logger will allow the device to start recording data.  Previously recorded 
data will be erased. 
 

Click on the Launch icon  in the toolbar, or click on the Device 
menu in the menu bar and move the cursor down to Launch… 
 
Once you have reviewed the settings, click Launch to begin logging.  
HOBOware Lite will remember the previous settings. Refer to Step 4 
to check Quirks Australia recommended settings. 
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HOBOware Lite will display the progress of the launch and warn you not to unplug the logger while it is 
being configured 
 
 
 
 
 
 
 

 
• Return the data logger to the Medisafe refrigerator, following the process in Step 5. 
 
• To retrieve the next data set, return to Step 6. 

 
 
Step 8 – Working with data 
 
To work with current readout data, skip to Viewing the plot. 
 
Opening a datafile 
Click the Open icon  in the toolbar, or choose Open Datafile… from the File menu then select a 
compatible file (.hobo, .hsec, or .hproj) and click Open. 
 
Viewing the plot 
The plot will display the temperature data for the period data was collected. This may be difficult to 
interpret, based on the how the plot is set up. To change the plot properties, right-click on the plot to 
display the following dialog.  
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In the Plot Properties menu, you may want to change the Time Axis, which will allow you to choose a  
specific time window by changing the minimum and maximum recording intervals. However, it is 
recommended you examine the entire time interval for any temperatures recorded outside the allowable 
range. You may also want to change the temperature range displayed, which is done by selecting 
Axis:”°C” Properties… 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Another way to accurately interpret temperature data is to display the individual points in the Points 
Table. To show the table, choose Points Table from the View menu. You can then click on specific 
times to display that record in the table. 
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Printing the datafile 
 
To set up the paper for printing the graph: 

• Choose Page Setup from the File menu. 
• Change the paper type, orientation, and margins as necessary, then click OK. 

 
To print the graph: 

• Click on the Print icon  in the toolbar, or choose Print… from the File menu. 
• Select the appropriate printer, if applicable, and click OK. 
 

 
Printing the points will print the data in numerical form.  
You are able to print all points, or a selection of points.  
 
To print the points, choose Print Points… from the File  
menu. 
 
To print a selection of points, highlight the points to  
print from the table with your mouse, before choosing  
Print Points… from the File menu. When the Print  
Selection dialog appears, you will be given the option of 
printing only the selected points. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
HOBO and HOBOware are registered trademarks of Onset Computer Corporation for its data logger products and 
configuration/interface software. Macintosh is a registered trademark of Apple, Inc. Windows 2000, XP and Vista are registered 
trademarks of Microsoft Corporation. All other trademarks are the property of their respective companies 
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      Control and Monitoring System 
 
Temperature Control System: 
 
This highly accurate electronic control incorporates a temperature probe and thermostat. 

• A temperature probe measures the air temperature in the cabinet. 
• The electronic controller is programmed to the required temperature parameters (+2 to +8°C). 
• The controller cycles the refrigeration system to maintain the air temperature inside the cabinet, 

within the required parameters. 
 
Should the temperature of the cabinet fall or rise outside the set parameters, the controller will trigger 
both an audible and visual alarm (the digital display will flash –“LO” for below set parameter or “HI” for 
above set parameter). 
 
A suitable delay (5 min.) is programmed into the system to prevent unnecessary false alarms (such as 
door being open for extended periods). 
 
 
If an alarm condition occurs, press  
the alarm mute button to silence the  
audible alarm. 
 
 
 
                  alarm mute button 
 
The electronic controller is pre-programmed, during the manufacturing process. 
The only button the customer is required to press is the prg/mute button. If the cabinet alarms, you can 
press this to silence it. Any reprogramming of the controller must be done by a person approved by 
Quirks Australia. 
 
When you first turn the cabinet on, if it does not reach a temperature below +8 °C within 10 minutes, it 
will alarm. This is a normal function. All you are required to do is press the prg/mute button to silence 
the alarm and restart the cooling process 
 
If an alarm condition has occurred, please allow 10-15 minutes for recovery. 
 
Should you experience any issues with the Medisafe refrigerator maintaining temperature within the set 
parameters, please contact Quirks Australia. 
 
 
 
 
.  
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High/Low Temperature Display: 
 
The top left display (pictured to the right) is the minimum and maximum 
thermometer reading. This displays the maximum and minimum air 
temperatures reached inside the refrigerator, since the last reset.  
 
Note: The maximum temperature will rise if the door is left open for an 
extended period of time.  
 

 It is essential that the reset button is pressed before leaving the 
premises to ensure a true reading is viewed the following morning.  
(Some regulations governing vaccine storage may require you to reset the 
display more frequently than once daily, please check with your State/Territory health authority for 
further information). 
 

 The current temperature before pressing the re-set button should be between the required 
temperatures of +2°C to +8°C. 
 
The High/Low Temperature Display is to be used as a guide only, providing an early indication of 
developing conditions inside the refrigerator. Always refer to your data logger for an accurate readout 
of vaccine core temperature. 
 
 
Data Logger: 
 
The data logger (pictured to the right) records vaccine temperature data over time 

 
• Temperature is recorded from a probe inside the refrigerator cabinet,  

surrounded by transfer gel, providing a simulated vaccine core 
temperature. 
 

• Temperature information is downloaded to a PC or Mac, using the  
HOBOware Lite software provided (see Setting up the data logger).  
 

 This information can be used in regulatory audits and insurance  
claims, to provide an accurate representation of vaccine core temperature inside the 
Medisafe refrigerator, during its operation. 
 

 Temperature patterns are recorded over time, providing indication of damaged seals, or 
changes in operating temperature. 

 

 The data logger must be connected to the PC immediately after it has been removed from the 
Medisafe for downloading, and reconnected to the Medisafe immediately after launching, otherwise 
false readings will result! 
 

 DO NOT USE vaccines exposed to temperatures below +2°C or above +8°C, as recorded by 
your data logger, without obtaining further advice. Do not discard these vaccines. Isolate vaccines 
and contact the State/Territory health authorities for advice on the National Immunisation 
Program vaccines and the manufacturer/supplier for privately purchased vaccines. 
Recommendations for the discarding of vaccines may differ between health authorities and 
manufacturers. Do not discard any vaccines until you discuss the necessary actions. 
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Auto Dialer (Optional): 
 
The auto dialer is an optional remote monitoring device contained within the control panel, connected to a 
dedicated analogue telephone line (it cannot be connected to digital or PABX systems). In the event of a 
power failure, the auto dialer will dial 5 pre-programmed phone numbers, in sequence, until the alarm is 
acknowledged. This will provide specified persons with notification that alternate vaccine storage 
arrangements are required to prevent loss of stock. 
 
 

Setup: 

• Connect the Auto Dialer phone jack to the wall socket, using the standard telephone cable 
provided. 

• Move the switch at the back of the header control panel to the ON position. 
 
 
The auto dialer has been programmed to ring the following phone numbers, in rotation, if an alarm 
condition occurs when the premises are unattended. (such as a power failure). 
 
1.   
2.   
3.   
4.   
5.   
 
 

Acknowledgement of Auto Dialer notification: 
 
• When the phone is answered, a unique (“whish”) sound will be heard. 

 
• The call must also be acknowledged by pressing “5” on the telephone keypad. 

 
• If the call is not answered, or rings out and goes to message bank, the auto dialer will not have 

received any acknowledgement and continue to dial the pre-programmed phone numbers in 
rotation until the call is acknowledged. 

 
 
* Should reprogramming of the auto dialer be required, please contact Quirks Australia at 1800 686 672  
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Troubleshooting 

 Caution: Service should be performed only by qualified maintenance or refrigeration 
mechanics.  For assistance, please contact Quirks Australia. 

Issue Possible Cause Further Information / Action to be taken 

Refrigerator will not run No power • Check that appropriate power is supplied to the 
unit. Before turning on check to see if it is safe!  

• Check fuses from main power supply. 

 

Temperature is too low 

 

Operating 
conditions 

• Check that there is sufficient air flow inside the 
refrigerator cabinet; that there are no large boxes 
or trays, stock is evenly distributed throughout 
the shelves, and there is space between stock and 
the evaporator plate at the rear of the cabinet. 

 

 

Operating 
conditions 

• Ensure that the unit is not located in direct 
sunlight, or in an area where the ambient 
temperature is above 30°C. 

• Check the condenser coil (located at the back of 
the unit) to ensure it is clean and not located in a 
confined space, so that air flow and heat 
dissipation are not restricted. 

• Check that the door has not been left open. 

• Check that the seal has not been damaged, 
allowing cold air to escape from the refrigerated 
cabinet. If a new seal is required, please contact 
Quirks Australia. 

 

 

System operating 
with low or high 
refrigerant 
pressures 

• If system is operating with pressure lower or 
higher than design refrigerant pressures.  It will 
have less cooling capacity.  

• High pressure can be the result of service issues 
such as dirty condenser coils, failed condenser 
fans, non condensables in the refrigeration 
system, system over-charge, or high ambient 
conditions.  A qualified refrigeration technician 
should be called to determine the problem and 
repair as required. 

• Low pressure problems can be the result of a 
low refrigerant charge, dirty evaporator, plugged 
refrigerant filter dryer, damaged capillary valve, 
high superheat adjustment, or failed evaporator 
fan. A qualified refrigeration technician should 
be called to determine the problem and repair as 
required. 

 

 

Temperature is too high 

 

Compressor 
problem 

• Compressor has internal damage, causing less 
cooling capacity.  
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Issue Possible Cause Further Information / Action to be taken 

High/Low Temperature 
Display reading incorrect 
temperature or blank 

Battery needs 
replacement 

• This must be performed by a qualified service 
technician. Please contact Quirks Australia.  

 

 

Not connected 
• When recording, ensure the temperature probe 

(grey cable at the back of the control unit) is 
connected to channel 1 on the data logger. 

• When downloading, ensure the data logger is 
connected it to the computer using the USB 
cable provided. If it is connected, it will be 
displayed in the HOBOware Lite status bar at 
the bottom-right of the screen. 

 

Logger not 
launched 

• Check the status of the logger, by connecting it 
to the computer using the USB cable provided 
and choosing Status from the Device menu.  If 
the logger has not been launched, follow the 
relaunching sequence (Step 7) on Page 8. 

 

Data Logger not recording 

Battery needs 
replacement 

• Disconnect the data logger from the refrigerator 
and PC. A small Phillips-head screwdriver is 
used to open the battery compartment. Replace 
the expired battery with a CR2032 lithium 
battery. 

 



 

Quirks Australia 
24 Hour National Service Support: 1800 686 672            17 

 
For further information regarding vaccine storage and handling, please refer to the National Vaccine 
Storage Guidelines: Strive for 5 (available from the Department of Health and Ageing, at 
http://www.immunise.health.gov.au/internet/immunise/publishing.nsf/Content/provider-store), or contact 
one of the following: 
 
National Immunisation Infoline  1800 671 811 
 
 
State and Territory Health Department  
telephone contact details for immunisation 
 
Australian Capital Territory   02 6205 2300 
ACT Health      
 
New South Wales    02 9391 9000 (Switchboard)   
Department of Health Contact your local Public Health Unit (look under "Health" 

in the White pages) for region-specific information 
 
Northern Territory    09 8922 8315 
Department of Health and Families 
 
Queensland     07 3234 1500 
Queensland Health 
 
South Australia    08 8226 7177 
Department of Health 
 
Tasmania     03 6222 7724 or 1800 671 738 (within Tasmania only) 
Department of Health and Human Services  
 
Victoria     1300 882 008 
Department of Human Services 
 
Western Australia    08 9321 1312 
Department of Health 
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